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EQ7 Printing Lessons Lesson 1: Printing Block Patterns

ELECTRIC QUILT 7 Lesson 1 - Printing Block Patterns

In these lessons we're going to focus on printing and use the Quick
Quilt projects as our “finished projects.”

Create a hew pioject | Open an existing project | Start with a quick-quit project

Click the pre-designed project pou want to open,

Use the amow buttons to view all the quilts in a
project. Click OK to open the project

Amish Double Nine Patch. TF7

Open the Log Cabin - Traditional Quick Quilt
1  Double-click the EQ7 icon on your desktop to open the
program. You'll see the EQ7 splash screen.

Applique Text TR?

Center Medallions. TF7
Drurkard's Path. TP7
Grandmather's Fan. TP7

Irish Chain - Double. TF7

Liog Cabin - Conternporary. TP7
Laog Cabin - Traditionsl. TP7

Lag Cabin - Twisted. TP?

NY Beauty - Contemparan.TP7
NY Beauty - Traditional. TR?
Sawtooth Chain TR7

Storm at Sea TP7

Streak of Lightning TP7

2 When the Tip of the Day appears, click Close.

3 In the Project Helper click the Start with a quick-quilt project

Table Runners. TF7 tab.
[Crep ][ ok ][ conce 4 Select the Log Cabin — Traditional project from the list and
S’rep 4 CliCk OK.

5  The Sketchbook will appear. Click the Quilts section.

Project Sketchbook

6 Select the first quilt in the Sketchbook and click Edit. The quilt

PROJECT

SKETCHBOOK [ ] will be sent to the worktable.
\ - ; Check out the Layout
Ui - 7  Click the Layout tab at the bottom of your screen.

B
B 8 Do not change any numbers. Look at the Finished Block Size.
It is 8.000 by 8.000.

Corons .
9  Click the Layer 1 tab at the bottom of your screen.

Print Block
e 10 Click the Select tool at the top of the right-hand toolbar.

Quit 1 of 5 auits
Sort.. |(Motecad. || Edt | Delete || Diose
T

STeI 6 11 You must tell EQ7 which block to print by selecting it. Click on
P a Log Cabin block in the quilt to select it.

EMBROIDERY

e 12 Click the Print button in the top toolbar and choose Block.

W e (FILE > Print > Block works too.)

Layout %| Borders | Layeri | WidthD 8.000
Step 7
Height 8.000

i

Step 8
Layout | Borders | Layer1 [} k |
Step 9 Step 10
Select
E Block...
Step 12
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(print Block 13 Under Printing Style, choose Outline drawing.

14 Click Preview at the bottom of the Print Block window. Outline

Block Name: ‘ Log Cabin . P . . .

Frished Block Sze drawing is just that... a black and white line drawing of the
Width: block.
Heitt

@ Use size from quitt
() Custom block size

15 Click Close at the top of the preview.

Step 13 T&j: i 16 Under Printing Style, choose Quilting stencil.
gr"::_m; 17 Click Preview. Any block in EQ7 can be used as a quilting
@Shmm;b:;s Copies — stencil and printed as a Quilting stencil.

Mumber of copiss: 1

18 Click Close at the top of the preview.

. felp ||Page Setup..| Fonts.. Preview ||  Prnt Close.
Step 14

19 Under Printing Style, choose As applique pattern.

20 Click Preview. You won't notice any difference between As
applique pattern and Outline drawing when it’s a pieced block.
You'll only notice a difference when printing an appliqué that has
overlapping patches.

21 Click Close.

Quitt: 36000 x72000 (ns)_ Mouse H: 1502 V: 421

Print block, Qutline drawing preview

Quitt: 36000 x72000 (ns)_ Mouse H: 1502 V: 421

Print block, Quilting stencil preview

Print block, As applique pattern preview 3



EQ7 Printing Lessons

Lesson 1: Printing Block Patterns

Mouse H: 1502 V: 421

Step 28

Step 26

Step 25

Step 29

Print block, Showing fabrics preview

-
Print Black

Block-Si

+HOptior

Block Name: |
Frished Block Size

Height:  2.000
() Uss size from quit

@) Custom block size
Printing Style
() Outline drawing
() Quitting stencil
) As appliqus pattsm
@ Showing fabrics

widh: B

Log Cabin

Copies
Number of copies: 1

[ Hobp [[Pagesetn. ] Fonts..

|[_Preview J[_ Pt || Cese |

-
Print Black

[=X=)

Block Size | Options

Pattem Style Options

Mirror

Line thickness:

Showing Fabric Style Options

[] Print block name

Print a5 many as fit

Frint block outiine

Print patch outline

B YT T T

Step 30

e 56.000 X T2.000 (ns) _ Mouse

Print block, Custom block size, print as many as fit

22 Under Printing Style, choose Showing fabrics.

23 Click Preview. Showing fabrics will print out a colored picture of

the block.
24 Click Close.
Note

You will usually always want to choose Use size from quilt when printing a block
from the quilt. Here's one exception:

25 Print Block can be used for more than just a picture of the block
as it is used in the quilt. Let’s see how to make gift tags. Under
Finished Block Size put the dot next to Custom block size.

26 Double-click the size for Width and type 2.

27 Press your TAB key to go to Height and type 2.

28 Click the Options tab near the top of the Print Block box.
29 Put a check next to “Print as many as fit.”

30 Click Preview. Imagine if you had a really cute birthday or
holiday block designed. You could print this on card stock,
cut out the blocks, punch holes in the corners and tie them to
presents with ribbon.

Note
You may want to dlick to remove the check from Print as many as fitwhile you
still remember it was checked now that we've tried it out

31 Click Close at the top of the preview screen.

32 Click Close in the bottom corner of the Print Block box to
return to the quilt.
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Print Foundation Pattern

% 33 The block should still be selected in the quilt. If it is no, click it
L4 with the Select tool again.
Block... 34 Click the Print button in the top toolbar and choose

| Eoundation Pattern... Foundation Pattern. (FILE > Print > Foundation Pattern
Step 34 works t00.) Depending on the type of foundation pattern, you
will either start on the Numbering or Sections tabs. There is also
an Options tab.

5 P Foundoion Pt == 35 Click the Options tab at the top of the Print Foundation
Step 35 — skl | Pattern window. Notice how Use size from quilt is already

Block Name: Log Cabin

selected and the grayed-out numbers are the numbers from our
e e ptn Layout tab (8.000 by 8.000).

With: 3000 [7] Print numbering

Height: 2000 - . . . .
Step 35 I ‘jr"'"m"”“" 36 Make sure Grayscale is checked and Mirror is unchecked in
7] Separate urits

() Custom block size . .
b Step 36 the options at the right.

Seam Alowance [¥] Grayscale . X
v (B L 37 Click Preview.

[¥] Print seam allowance

pcney Note
e Your printout will most likely ile over two pages. When printing an 8 inch
by 8 inch pattern with a ¥4 inch seam allowance around it, you are trying to
i print 8"4 inches of pattern total. If your paper size is only 8Y4 inches wide and
Step 37 absolutely needs printer margins, of course your pattern will always tile onto
multiple pages. It is unavoidable.

Hep | [PageSetp.| [ Fonts. | [ Preview |[ Pit | [ Gose
I

YA Untitied - £Q7 (E=eT)

e e e T Luckily, EQ7 prints a dashed and dotted line at the page break. When you
line up the two pages and tape them together, they will make the full pattern.
= Use the dashed and dotted lines as well as the black seam lines and seam
allowance lines all as guides when lining up pages together. If you don't have
a light box to use, try taping patterns to a large window or sliding glass door
during the day.

As long as you line up all the guides, you will get the perfect pattern as if you
printed it on a wide format printer or plotter.

38 Day attention to the side of the block on the left is dark gray.
. Click Close.

nnnnn Qi 55000 x72000 () _ Mouse s 3165 Vs -576

39 Put a check next to Mirror and click Preview again. Now the

Print Foundation Pattern, Mi hecked previ
rint roundarion rarrern, Mirror uncheckea preview gray has ﬂipped horizontally.

Notes
Ca e e e s s * Mirror is very important to understand. Depending on your foundation
piecing technique you may or may not need to have Mirror checked. If
e you're doing a directional pattern (like an alphabet “R” block), it could
mean the difference between having your block turn out correctly or
suddenly ending up with a “rag quilt” where your seam allowances are on
the incorrect side.

* Foundation Piecing also has a “Print as Many as Fit” feature. It works best
for patterns that print in one unit (like a Log Cabin, Pineapple, or Square in
a a Square), when they are printed small.

40 Click Close at the top of the preview.

aaaaa

Print Foundation Pattern, Mirror cecked, preview 41 Click Close in the bottom corner of the Print Foundation
Pattern box to return to the quilt.
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’g Print Templates
= . 42 The block should still be selected in the quilt. If it is not, click it
Block... with the Select tool again.
Foundation Pattern... 43 Click the Print button in the top toolbar and choose Templates.
| T (FILE > Print > Templates works too.)
Templates...
Step 43 44 Notice how Use size from quilt is already selected and the grayed
out numbers are the numbers from our Layout tab (8.000 by
8.000). Click the Preview button.
Print Template | ) Note
S = RULE #1: When printing a pattern from a quili, ALWAYS leave it on “Use size
widihe | 8.000 from qw/t “
Height 2000
Step 44 i 45 Templates will give you each unique piece of the pattern. The

dotted line around the patch is your seam allowance line (where

Seam Allowance
widh: 125 you would cut). The black solid line is your sewing line (where

[¥] Print seam allawance

your seam would be).

Piint Key Block
S e 46 Click Close at the top of the preview.
Line Thickness Copies
3 ) ] .
- Mot 47 Click Close in the bottom corner of the Print Template box to

[ Help HF’age Satup...H Fortts... I[ Preview 1 [ Frint ][ Close ] return to the qullt.
I
T

Step 44
¥4 Untitied - EQ7 — .

===== Quit 55000 x72000 (i) Mouse s 2538 s -576

Print Templates preview
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2

Block...

Foundation Pattern...

Templates...

Rotary Cutting...

Step 49
Print Rotary Cutting Chart Léj
Elock Name: Log Cabin
Finished Block Size
Width  [8.000
Height: | 8.000
@ Use size from quilt
Srep 50 () Custom block size
Seam Allowance
wide 25
PFrint K.ey Block.
@ Smal ) Large “ p] ’ "
Round to Nearest Copies
148 @ 1416 Number of copies: 1
Chart shows only rotary cuttable patches. See Help for more information.
Hel Page Setup... Fonts... P Frint Ch
| elp H 'age Setup. || ants. ” rerlew“ i ]| ose J
Step 50
¥4 Uniiied - £Q7 =)
) (Zoom Gose
mErim ‘I - E-
s P
HET [ =
= . L
‘ T m- ™
o * 1
e
s =
oo O : ‘ I o
- s
P H- m T H-
et
: T om-
——

aaaaa

Print Rotary Cutting preview

Print Rotary Cutting
48 The block should still be selected in the quilt. If it is not, click it
with the Select tool again.

49 Click the Print button in the top toolbar and choose Rotary
Cutting. (FILE > Print > Rotary Cutting works too.)

50 Notice how Use size from quilt is already selected and the
grayed-out numbers are the numbers from our Layout tab
(8.000 by 8.000). Notice also how you can round to the nearest
1/8th or 1/16th inch. Click the Preview button.

Notes
The chart updates according to how the quilt is colored. If you decide to change
the quilt to blue and purple, all those fabric swatches would update as well.

Rotary Cutting is great when you use blocks in quilts af the size they were
designed for. This log cabin is based off a grid of 8 (three logs on each side
and the center counts as 2, 3+2+3=8). That's why the block in the quilt on the
Layout tah is 8.

Seam allowance is added around each patch. Then those dimensions are found
on the ruler. If a number is not on the ruler, the number is rounded (to the
nearest 1/8th or 1/16th). You will not have problems with rounding for this
Log Cahin block at 8 inches. There would, however, be rounding if your tried
printing it at 7 inches. Please see Chapter 10 in the User Manual for “How to
Avoid Rounding in Rotary Cutting.”

If a complex pattern (with 5-, 6- or many-sided patches) ever skips a rofary
cutting patch in the chart, that's because the patch would be most accurate as
a template. So, print rotary cutfing... if a patch is skipped, print Templates and
use the template for the missing patch.

51 Click Close at the top of the preview.

52 Click Close in the bottom corner of the Print Template box to
return to the quilt.

53 Great job! Those are all the options for printing out block
patterns. Stay tuned for how to print patterns for the quilt
and images too. If you would like to practice this lesson again,
choose the Sawtooth Chain quick-quilt project in step 4. That
way you can see how templates, foundation patterns, and rotary
cutting charts differ when there are triangular patches. If you
need help deciphering how many patches to cut, see Chapter 10
in the User Manual for “Printing a Rotary Cutting Chart.” Click
the X in the top-right corner to close the program.

Note

If you just want to print a pattern, you don’t need fo design a whole quilt. In
EQ7 click VIDEQS on the top menu bar and watch video #8, “What if I just
want a pattern?”



